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 25 

Abstract 26 

Setting an open-access computer assisted sperm analysis (CASA) may benefit the 27 

evaluation of motility in mammalian sperm, especially when economic constraints do not 28 

allow the use of a commercial system. There have been successful attempts to develop 29 

such a device in Zebra fish sperm and the system has been used in very few studies on 30 

mammalian spermatozoa. Against this background, the present study aimed at developing 31 

an open-access CASA system for mammalian sperm using the horse as a model and based 32 

upon the Image J software previously established for Zebra fish sperm. Along with 33 

determining the sperm progressive motility and other kinetic parameters (such as 34 

amplitude of lateral head displacement), the “results” window was adjusted to simplify 35 

subsequent statistical analyses. The path window was enriched with colored sperm 36 

trajectories on the basis of the subpopulation they belong to and a number that allowed 37 

the sperm track to be associated to the sperm motility data shown in the “results” window. 38 

Data obtained from the novel plugin (named as CASA_bgm) were compared with those of 39 

the commercial CASA Hamilton-Thorn IVOS Vers.12, through Bland Altman’s plots. While 40 

the percentage of total and progressive motile sperm, VCL, VAP, VSL, LIN and STR and 41 

ALH were in agreement with those obtained with the commercial system, BCF significantly 42 

differed between the two systems probably due to their settings. Interestingly, a positive 43 

and significant correlation between the percentages of total motile sperm evaluated 44 

through CASA_bgm and those showing high mitochondrial membrane potential evaluated 45 

by JC-1 staining was found. In conclusion, CASA_bgm ImageJ plugin could be useful and 46 

reliable for stallion sperm motility analysis and it is our aim to apply this system to other 47 

mammalian species.  48 

 49 

Keywords: CASA; stallion; sperm motility; sperm quality 50 

 51 
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1. Introduction 53 

 54 

At present, more than 12 different computer-assisted sperm analysis (CASA) 55 

systems are available for sperm motion detection in spermatology labs and in commercial 56 

semen production units (Amann and Waberski, 2014). The development of a powerful 57 

CASA software has made possible kinetic studies of spermatozoa and objective 58 

measurements of sperm movements (Verstegen et al., 2002). 59 

The evaluation of sperm motility and other kinetic parameters such as curvilinear, 60 

straight line, and average path velocities, is an essential part of sperm quality examination 61 

in many mammalian species. Despite the immediacy and accuracy of these softwares, 62 

several investigators rely on non-automated analysis due to the high cost of commercial 63 

options. CASA systems historically evolved for commercial purposes and were initially sold 64 

to clinical laboratories to assess human sperm fertility (Amann and Katz, 2004). Later on, 65 

CASA systems were produced for stallion sperm analysis by Hamilton-Thorne in 1986, and 66 

soon after they were adapted to many species. In spite of being much widespread across 67 

research laboratories, “teaching the instrument” is still needed, as reported by Amann and 68 

Katz  (2004). 69 

The availability of an open-access, low cost CASA system could much benefit the 70 

analyses of sperm motility, especially for those that, due to economic constraints, may not 71 

afford the costs of a commercial device. In addition, the relevant information that a CASA 72 

system provides goes beyond a more objective evaluation of the percentages of total and 73 

progressive motile sperm. Indeed, some CASA systems give the individual kinetic 74 

parameters for a single sperm cell and this may be used for evaluating motile sperm 75 

population in differently treated samples (Abaigar et al., 1999; Flores et al., 2009, 2008; 76 

Miró et al., 2005,  2009; Schmidt and Kamp, 2004; Varner, 2008). In 2007, Wilson-Leedy 77 

and Ingermann developed a CASA software package that worked as a plugin to the United 78 

States National Institutes of Health (NIH) Image J software (Wilson-Leedy and Ingermann, 79 

2007). Successively, more than hundred scientific studies used the plugin to assess fish 80 

or invertebrate sperm motility. In particular, Purchase and Earle (2012) implemented the 81 

original plugin, creating a new one that permits the automation of some video processing 82 

steps. Very few studies applied the system to mammalian sperm motility evaluation. 83 

Elsayed et al. (2015) used the plugin to study sperm motility in bull and adapted the 84 

system to their specific experimental conditions. . Boryshpolets et al. (2015) used the 85 
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original plugin to study human sperm motility in response to thermotaxis. Since this 86 

plugin deposited is an open source, this allows any research laboratory to have access to 87 

CASA software and to perform the motility sperm analysis. 88 

The first aim of our study was to set up an Image J CASA system for mammalian 89 

sperm analysis, using the horse as a model, and also including progressive motility and 90 

amplitude of lateral head displacement measurements; second, we compared the results 91 

obtained with our system to those of a commercial one and to the data reported in the 92 

literature. Finally, we checked the correlations between motion values obtained from the 93 

two CASA systems and other parameters of semen quality such as mitochondrial activity 94 

and acrosome integrity. 95 

 96 

97 
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2. Materials and methods 98 

 99 

2.1. Collection and preparation of semen 100 

 101 

Twenty-five ejaculates were collected from four Standardbred stallions of proven 102 

fertility, individually housed at the National Institute of Artificial Insemination (University 103 

of Bologna, Italy), using a Missouri artificial vagina with an inline filter (Nasco, Fort 104 

Atkinson, WI, USA). Semen was diluted in Kenney's extender (Kenney et al., 1975) at a 105 

semen/extender ratio of 1:3 (v:v) and sent to the laboratory within 1 h post-collection at 106 

20-25°C.  107 

Upon arrival, an aliquot of 2 mL of extended semen was further diluted to a final 108 

concentration of 30x106 spermatozoa/mL, and then split into three aliquots. One was 109 

evaluated with the Hamilton-Thorne CASA system Vers.12, another was evaluated with 110 

the Image J software and the new CASA_bgm, and the last one was used to evaluate the 111 

sperm viability with mitochondrial membrane potential and acrosome integrity. 112 

 113 

2.2. Video microscopy system for motility assessment 114 

 115 

Settings for video camera and microscope were established according to the 116 

indications of Wilson-Leedy and Ingermann (2007) and a Leitz diaplan microscope (Wild 117 

Leitz GmbH, D6330, Wetzlar, Germany) with a 10x plan objective with negative phase-118 

contrast was used. The microscope was equipped with a Z31A Ascon technologic heated 119 

stage (Ascon technologic, PV – IT). The video camera, 3.1 megapixel CMOS USB 2.0 120 

Infinity1-3 Camera (Lumenera corporation, Ottawa, ON, Canada), was coupled to the 121 

microscope by a c-mount adapter and videos were registered for three seconds at a 122 

resolution of 800x600 pixel and 60 frames/sec (fps). Images were recorded on a hard drive 123 

using the Infinity analyzing and capture software 6.4 (Lumenera corporation) and 124 

converted to avi format. 125 

Prior to any observation, spermatozoa (30x106 sperm/mL) were loaded onto a fixed 126 

height Leja Chamber SC 20-01-04-B (Leja, CIUDAD; The Netherlands). Five videos of 127 

separate fields and lasting three seconds each were recorded per sperm sample. 128 

 129 

2.3. Installation of plugin and video adjustment and analysis 130 
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 131 

The indications of Wilson-Leedy and Ingermann (2007) were followed to install the 132 

plugin and to import the central second of each video. After importing, each video was 133 

converted into greyscale 8-bit image and the threshold was adjusted to highlight the sperm 134 

heads over the background. 135 

Launching the plugin results in the initiation of a dialog box, where parameters for 136 

analysis need to be indicated. In order to adapt the existing plugin to the analysis of 137 

mammalian spermatozoa, the input parameters related to the bulk flow were eliminated. 138 

Therefore, the dialog box generated for CASA_bgm is more simple than that of CASA and 139 

the implemented input settings consisted of two VAP cut-off values that divided the sperm 140 

population into slow, medium and rapid spermatozoa. The input parameters used to 141 

identify and characterize the sperm motion are reported in Figure 1. 142 

As shown in Figure 1a, the first two (a and b) parameters regard the minimum and 143 

maximum pixel areas that the program takes into account for the analysis. The particles 144 

over or below the selected area are not analyzed. The minimum track length (c) indicates 145 

the minimum number of frames in which a particle must appear in the video in order to 146 

be considered in the analysis. The maximum sperm velocity between frames (d) regards 147 

the maximum distance a spermatozoon would be expected to travel within the time period, 148 

so it is related to the sperm cells velocity.  149 

The cut-off values for VSL, VAP and VCL for a spermatozoon to be considered as 150 

motile are given in rows e, f and g. In addition, VAP cut-off values for slow and medium 151 

velocity spermatozoa, which are then used to describe the sperm subpopulations based 152 

upon the VAP, can be set in rows h and i. In row l, the user inserts the number of frames 153 

acquired per second, whereas the ratio µm:pixels of the particles analyzed should be 154 

indicated in the following field (row m). Rows n, o and p are binary variables: 0 will not 155 

produce the specific output, while 1 is the positive choice and will produce an output. 156 

As far as the two “advanced parameters” are concerned, they were included in order 157 

for the progressive motility to be determined; therefore, field q is the VAP cut-off and field 158 

r is the straightness cut-off for progressive motile cells. Each analysis needs the 159 

parameters to be entered correctly by the user. To automatize this procedure, Image J 160 

function called Macro recorder could be used. 161 

 162 

2.4. Output and successive analysis 163 
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 164 

Outputs obtained from CASA_bgm additional parameters were implemented to 165 

CASA plugin to match the needs of analyzing mammalian spermatozoa. The output, as the 166 

pre-existing, shows two windows: Results and Path. On the Results window, and 167 

depending on the choice made in fields n, o and p, it is possible to obtain: 168 

 169 

- x and y coordinates for each spermatozoon analyzed when the number “1” is entered 170 

in field “n” 171 

- motility parameters for each spermatozoon analyzed when the number “1” is 172 

selected in field “o” (Fig. 2) 173 

- the mean and median values for the sperm when the number “1” is selected in field 174 

“p” (Fig. 2) 175 

 176 

When typing 1 in row “o”, the Results window shows a list of individual sperm 177 

motion parameters, where the following values related to each spermatozoa were analyzed: 178 

VCL, VAP, VSL, LIN, STR, WOB, Beat Cross Frequency (BCF) and ALH appear in each row. 179 

Excluding ALH, algorithms for other parameter calculations are the same used in the pre-180 

existing CASA plugin (Wilson-Leedy and Ingermann, 2007). Instead, ALH values were 181 

worked out following Mortimer (2000). Finally, the last row summarizes the total number 182 

of sperm analyzed in the selected frames. 183 

By selecting the third set of parameters (row “p”), the output of Results shows 184 

average (Avg) and median (Median) values for the populations of sperm examined, with the 185 

respective standard deviations (Sigma). Additionally, the same output shows the numbers 186 

of total (Total Sperm), total motile (TM), progressive motile (PM), slow, medium and rapid 187 

spermatozoa analyzed. If multiple analyses are performed, the results of each analysis are 188 

added to new rows below and are depicted in the Results window. Moreover, the plugin 189 

also produces an output window called Path (Fig. 3), that is an image showing the paths 190 

of each single spermatozoon. In CASA_bgm, black marks identify non-motile sperm, whilst 191 

paths of motile sperm are traced with different colors indicating different velocities, so that 192 

red, yellow and green colors are utilized for rapid, medium and slow sperm, respectively. 193 

This classification is made on the basis of VAP. In addition, each path of motile sperm is 194 

tagged with an ordinal number that corresponds to the order through which spermatozoa 195 

are listed in the Results windows. 196 
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 197 

 198 

2.5. Image J settings (Macro Horse) 199 

 200 

We set the parameters for performing the motility analysis with horse spermatozoa 201 

in accordance to the Standard Operating Procedure of Italian Experimental Institute 202 

“Lazzaro Spallanzani” (Law D.M. 403/2000). The same values of VAP and STR for PM 203 

evaluation were used for the analyses with Hamilton CASA system.  204 

The parameters chosen for this purpose are shown in Figure 1. 205 

 206 

2.6. Motility evaluation using Hamilton CASA system 207 

 208 

Motility was measured using a Hamilton Thorne, IVOS Ver. 12. Sperm cells were 209 

evaluated for each sample diluted to 30x106 sperm/mL using a fixed-height Leja Chamber 210 

SC 20-01-04-B (Leja, The Netherlands). The assessed sperm motility were: proportions of 211 

total motile (TM) and progressive motile (PM) spermatozoa, curvilinear velocity (VCL, μm·s-212 

1) mean velocity (VAP, μm·s-1), straight-line velocity (VSL, μm·s-1), straightness (STR, %), 213 

linearity (LIN, %), beat cross frequency (BCF, Hz), and amplitude of lateral head 214 

displacement (ALH, μm). The settings were as follows, frames per second: 60; number of 215 

frames: 45; threshold path velocity: 15 μm·s-1; and straightness threshold: 75%. 216 

 217 

2.7. Sperm mitochondrial activity and viability and acrosome integrity 218 

Unless otherwise stated, all chemicals were purchased from Sigma–Aldrich (Milan, 219 

Italy). 220 

 221 

2.7.1. Evaluation of mitochondrial activity and viability 222 

For each sample, an aliquot (25 μL) of semen (30 x 106 spermatozoa/mL) was 223 

incubated with 2 μL of a 300 μM propidium iodide (PI) stock solution, 2 μL of a 10 μM 224 

SYBR green-14 stock solution, both obtained from the live/dead sperm viability kit 225 

(Molecular Probes, Inc.) and 2 μL of a 150 μM JC-1 solution for 20 min at 37°C in the 226 

dark. Ten μL of the sperm suspension were then placed on a slide and at least 200 227 

spermatozoa per sample were scored using a Nikon Eclipse E 600 epifluorescence 228 

microscope (Nikon Europe BV, Badhoeverdop, The Netherlands). Spermatozoa stained 229 
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with SYBR-14 but not with PI were considered as viable (SYBR-14+/PI-), whereas SYBR-230 

14+/PI+ and SYBR-14-/PI+ spermatozoa were considered as non-viable. JC-1 monomers 231 

emit green fluorescence in mitochondria with low membrane potential (JC-1-) and form 232 

aggregates in mitochondria with high membrane potential (JC-1+), then emitting a bright 233 

red-orange fluorescence. Therefore, those viable sperm showing orange-red fluorescence 234 

in the mid piece (JC-1+) were considered as viable sperm with high mitochondrial 235 

membrane potential (SYBR-14+/PI-/JC-1+). 236 

 237 

2.7.2. Evaluation of acrosome integrity 238 

The integrity of the acrosome was evaluated using FITC-conjugated agglutinin 239 

derived from Pisum sativum (FITC-PSA) that specifically binds to α-mannoside sugar 240 

residues found within the acrosomal contents. Briefly, spermatozoa were washed twice 241 

with PBS and subsequently fixed and permeabilized with 95% ethanol at -20ºC for 30 min. 242 

Sperm were placed onto microscope slides, air-dried, and incubated with FITC-PSA (0.1 243 

mg/mL PSA-FITC) for 15 min at room temperature in the dark. Samples were finally 244 

examined under the aforesaid microscope, and 200 cells were counted. Acrosomes were 245 

considered as intact when stained with FITC-PSA, and damaged when presenting total or 246 

partial loss of FITC-PSA- fluorescence. 247 

 248 

2.8. Statistical analyses 249 

Data were analyzed with a statistical package (IBM SPSS for Windows Ver 21.0; IBM 250 

Corp., Chicago, IL, USA) and are expressed as mean ± standard deviation. After 251 

determining the normality and homogeneity of variances through Shapiro-Wilk and Levene 252 

tests, a t-test comparing the two CASA devices was conducted. Data were transformed 253 

through √x or arcsin √x when required. The agreement between the two systems’ results 254 

was studied by Bland Altman’s plots. Correlations between kinetic parameters and sperm 255 

viability, mitochondrial activity and acrosome integrity were determined through Pearson 256 

correlation. In all cases, the level of significance was at least at P≤0.05. 257 

258 
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3. Results  259 

 260 

Motility parameters obtained from CASA_bgm plugin and Hamilton-Thorne IVOS 261 

are shown in Table 1. Total and progressive motility values were similar, with no significant 262 

differences between paired samples.  263 

 The agreement between the two systems’ measurements was assessed by Bland 264 

Altman’s Plot (see Supplementary file 1). The different parameters showed a good 265 

agreement, in particular TM, PM, VAP, VSL , STR, LIN. VCL, BCF and ALH showed good 266 

agreement with some data outside the ± 2 SD. 267 

 Tables 2 and 3 show the correlation between sperm motility parameters, evaluated 268 

through the two CASA systems (CASA_bgm and Hamilton CASA respectively), and the 269 

percentages of viable sperm cells with active mitochondria (SYBR-14+/PI-/JC-1+) and 270 

sperm with intact acrosomes (PSA+). 271 

 Results from CASA_bgm showed a significant positive correlation with the 272 

percentage of motile sperm (total motility) and the percentage of SYBR-14+/PI-/JC-1+ 273 

sperm (P<0.001). Moreover, motility variables such as VAP, VSL and WOB evaluated 274 

through CASA_bgm showed a significant negative correlation with the percentage of sperm 275 

exhibiting an intact acrosome (P<0.05). Finally, a significant positive correlation between 276 

BCF evaluated by CASA_bgm and sperm with intact acrosomes was observed (P<0.05). 277 

 With regard to the motility parameters obtained through Hamilton CASA analysis, 278 

only a significant negative relationship between ALH and sperm with intact acrosome was 279 

observed (P<0.01). 280 

281 
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4. Discussion 282 

 283 

The present study aimed at setting an open-access CASA system for evaluating the 284 

motility of mammalian sperm from adapting the system developed by Wilson-Leedy and 285 

Ingermann , (2007) for fish sperm. In effect, the original ImageJ-plugin created by these 286 

Authors was intended to fish sperm and, consequently, requires some adaptation and 287 

implementation to fit the request of a standard mammalian sperm analysis. Therefore, the 288 

first objective was to modify the previously mentioned plugin, adding the progressive 289 

motility and amplitude of lateral head displacement, that were absent in the original 290 

version. For this purpose, two new fields were added to the input window and an algorithm 291 

was created ex novo. Moreover, we included three additional fields in the input window in 292 

order to classify as “slow”, “medium” and “rapid” spermatozoa, as other systems, like the 293 

Hamilton-Thorne IVOS, do. 294 

After adding or completing the input setup, we also introduced some modifications 295 

in the output window. Briefly, we included the progressively motile sperm count (PM) and 296 

amplitude of lateral head displacement measure (ALH) in the outputs, as well as the 297 

number of total motile sperm and the total count of sperm analyzed. This allows a better 298 

and faster use of these data for further statistical analyses. Regarding the “Paths” window, 299 

our output allows to distinguish through the track color between static (black paths), slow 300 

(green paths), medium (yellow paths) and fast (red paths) sperm. This classification 301 

originates from the different cut-off VAP values, which are set in the input window and 302 

may be modified and adapted to the peculiarities of other mammalian species. In addition, 303 

each sperm track is associated with a number, which allows the user to identify quickly (if 304 

sperm concentration is not too high) the path of a given spermatozoon and to associate it 305 

with the single data obtained in the results window. Thus, each number corresponds to a 306 

specific line in the results window (e.g. number 1 correspond to the first row, etc.). 307 

We analyzed 25 samples from four stallions with both Hamilton-Thorne IVOS and 308 

CASA_bgm Image J plugin. To avoid any technical differences, we used the same sperm 309 

concentration for both instruments, as recommended by Holt and colleagues (Holt et al., 310 

1996, 1994). Leja chambers were also used, as it is well known that different supports 311 

yield different results on the motility parameters (Hoogewijs et al., 2012). Finally, our 312 

settings for determining the sperm motion took into account previous studies. Indeed, and 313 

as reported by (Holt et al., 1996), there have been several approaches to detect properly 314 
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the true movements of sperm cells, and to distinguish motile from non-motile spermatozoa. 315 

In this regard, it has been reported that VAP values around 20 μm·s-1 or less could be due 316 

to spurious movements of non-viable sperm. 317 

It is worth noting that our results on TM, PM, VCL, VAP, VSL, STR and LIN obtained 318 

with CASA_bgm are consistent with those obtained by the Hamilton-Thorne CASA. It 319 

should be pointed out that data from our instrument and the commercial one are 320 

numerically different, but the excursion of measurements between the two systems is not 321 

significant. Our coefficients of variation are also in agreement with data reported by other 322 

Authors (Holt et al., 1994), who found values exceeding 20%. In that work, CV for total 323 

motility, VCL, VAP, LIN and ALH were 24%, 19%, 44%, 22.5% and 39%, respectively. The 324 

higher degree of variation of that work is possibly due to the comparison between 325 

numerous systems (five CASA). In the present study, although Hamilton Thorne CASA 326 

showed lower CV than CASA_bgm, the extent of these differences was not as high as that 327 

reported by other Authors (Holt et al., 1994). Moreover, BCF, was quite different between 328 

the two systems. This could be due to the difference in the algorithms between software. 329 

Indeed, various CASA systems, which generally utilize proprietary software, use different 330 

algorithms to determine the same measures. Therefore, in the absence of a “gold standard” 331 

with reference value, internal validation is required, which is setting-, system-, and 332 

species- specific (Amann and Waberski, 2014).  333 

Besides, a new parameter ALH, not originally present in the Image J CASA, was set 334 

on the basis of the algorithm proposed by Mortimer (2000). In this context, it is worth 335 

noting that Holt et al. (1994) reported that caution is needed when comparing results 336 

between CASA systems, particularly with regard to ALH and VAP. Not only do our data 337 

support this idea, but also indicate that such assertion could be extended to the other 338 

kinetic parameters. In addition, sperm preparation, previous incubation periods, qualities 339 

of optics, camera and imaging are amongst the factors responsible for the differences 340 

between CASA devices. Therefore, a direct comparison between such devices is not possible 341 

(Holt et al., 1996). Apart from this, one should note that other researchers have also 342 

pointed out additional critical steps in semen motility analysis, ranging from sample 343 

preparation (Contri et al., 2010) to the support used (Hoogewijs et al., 2012). 344 

The original plugin was already tested with fish sperm in comparison with two other 345 

systems (Boryshpolets et al., 2013). In that study, Image J plugin was shown to be in 346 

accordance with the other two examined systems, but for determined conditions (different 347 
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frame rate) and fish species, VCL from Image J and CRISMAS CASA systems were in 348 

accordance, while the Hobson Sperm Tracker was not. 349 

 Since a reliable method to evaluate sperm motility should give a global picture of 350 

sperm quality and should be in agreement with other sperm parameters, such membrane 351 

integrity, the second part of the work was intended to correlate the motility values obtained 352 

from the two CASA systems with sperm mitochondrial activity and acrosome integrity. 353 

Interestingly, we observed that the motion values obtained by CASA_bgm were better 354 

correlated with the other sperm quality parameters than those obtained through the 355 

commercial CASA. Indeed, a significant positive correlation between TM and the 356 

percentage of SYBR-14+/PI-/JC-1+ positive sperm was observed, kinetic parameters such 357 

as VAP, VSL and WOB showed a significant negative correlation with the percentage of 358 

sperm exhibiting an intact acrosome. The correlation between TM and viability and 359 

mitochondrial activity has been previously demonstrated (Bucci et al., 2016; Plaza Dávila 360 

et al., 2015). The significant and positive correlation between all these parameters 361 

corroborates the reliability of CASA_bgm. Moreover the relationship between the single 362 

kinetic sperm characteristics and its functional status, in terms of viability, mitochondrial 363 

activity and acrosome integrity, could be interesting for further investigations, since they 364 

could improve the predictive accuracy of the true sperm’s fertilizing potential ((Jung et al., 365 

2015; Nagy et al., 2015; Oliveira et al., 2013; Santolaria et al., 2015). In addition, the 366 

motion values of individual spermatozoon analyzed, which can be recorded by CASA_bgm, 367 

could be useful to study sperm subpopulations, after various techniques for processing 368 

semen, such as cryopreservation, capacitation or hyperactivation (Henning et al., 2014; 369 

Martínez-Pastor et al., 2011). In fact, mounting evidence indicates that the distribution of 370 

spermatozoa in different subpopulations based on motion features may have functional 371 

relevance and can be useful to study sperm biology (Amann and Waberski, 2014). 372 

 Finally, and as for the possibility of using CASA_bgm for other mammalian species, 373 

it is possible to establish specific settings for each species analyzed and to easily modify 374 

these parameters in the input. Two studies applied so far the original CASA plugin to 375 

mammalian species (Boryshpolets et al., 2015; Elsayed et al., 2015): the first one analyzed 376 

human sperm motility parameters (only VCL, VAP, VSL, LIN and WOB) by the enhanced 377 

CASA version (Purchase and Earle, 2012). Those Authors studied the thermotactive 378 

behavior of spermatozoa subjected to different temperature (31°C then 37°C and again 379 

31°C) and obtained interesting results on sperm parameters changes. The second study 380 
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developed a new CASA system for the analysis of bull spermatozoa under very particular 381 

experimental conditions: in fact, those Authors implemented the original plugin to study 382 

bull spermatozoa in different microfluidic environments. These two studies demonstrate 383 

that the plugin is reliable and could also be used properly for mammalian sperm. Anyway, 384 

Boryshpolets et al. (2015) did not improve the original plugin, while Elsayed et al. (2015) 385 

did improve it, with very new peculiar parameters (orientation, proximity to wall, 386 

swimVAP). In the present work, we added progressive motility (PM) and amplitude of lateral 387 

head displacement (ALH),  two parameters that are important for all sperm analyses and 388 

also for detecting or defining hyperactivation (Cremades et al., 2005; Schmidt and Kamp, 389 

2004). Furthermore, being this software an open source, any investigator may freely 390 

implement or modify (as we and others already did) the plugin and create a more specific 391 

or versatile system, according to his/her needs; this could then be made available to the 392 

whole scientific community, which would benefit from that tool. 393 

 In conclusion, the present study demonstrates the possibility of implementing an 394 

open-access CASA for evaluating stallion sperm motility and to easily adapt this 395 

background to other mammalian species. Whilst no “gold standard” is available to assert 396 

which system is the most suitable, the high and significant correlation of those sperm 397 

kinetic parameters evaluated through CASA_bgm with other sperm quality parameters, 398 

including membrane integrity and mitochondrial activity, demonstrates the reliability of 399 

this tool. This open source system could benefit those researchers that cannot afford the 400 

purchase of a commercial CASA system. 401 

 402 

The plugin is provided as an e-component of the present article (see e-component. 403 

BGM_java) 404 

  405 
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Table 1. Motility parameters from CASA_bgm and Hamilton-Thorne IVOS 506 

 507 

 CASA_bgm % CV IVOS % CV Paired t-test 

p value 

% Total 

CV  

% TM 75.27±10.80 18.22 78.64±11.43 14.23 =0.05 16.64 

% PM 37.04±11.21 30.36 37.96±9.33 24.97 >0.05 27.62 

VCL 203.24±33.67 16.50 190.78±19.43 9.61 >0.05 13.69 

VAP 110.98±26.81 22.88 101.20±13.54 13.30 >0.05 19.29 

VSL 75.02±15.20 18.89 71.49±11.52 17.35 >0.05 18.06 

LIN 38.20±5.70 14.49 38.12±3.94 11.78 >0.05 13.12 

STR 69.25±7.13 9.51 69.44±5.12 7.95 >0.05 8.69 

WOB 54.21±6.94 12.32 NA NA NA 12.32 

BCF 28.19±2.39 9.11 40.78±2.40 6.18 <0.01 20.69 

ALH 8.10±1.49 17.78 7.64±0.51 7.45 >0.05 14.01 

 508 

Abbreviations:  TM – total sperm motility; PM – Progressive sperm motility; VAP – average 509 

path velocity; VSL – straight line velocity; VCL – curvilinear velocity; ALH – amplitude of 510 

lateral head displacement; BCF– beat cross frequency; STR – straightness of track; LIN – 511 

linearity of track; WOB – wobble. CV – coefficient of variation. Data are reported as mean 512 

± SD. 513 
 514 
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Table 2. Correlation between CASA_bgm parameters and percentage of sperm with 516 

intact acrosome and percentage of viable sperm with active mitochondria. *P<0.05 517 

**P<0.01 518 

 519 

  % Sperm with an intact acrosome 
% SYBR-14+/PI-/JC-1+-sperm 

 

TM 0.32 0.47** 

PM 0.33 0.17 

VCL -0.24 0.28 

VAP -0.39* 0.21 

VSL -0.45* 0.17 

LIN -0.25 -0.17 

STR 0.08 -0.10 

WOB -0.41* -0.05 

BCF 0.38* 0.11 

ALH -0.31 0.25 

 520 

Abbreviations:  TM – total sperm motility; PM – Progressive sperm motility; VAP – average 521 

path velocity; VSL– straight line velocity; VCL – curvilinear velocity; ALH – amplitude of 522 

lateral head displacement; BCF – beat cross frequency; STR – straightness of track; LIN – 523 

linearity of track; WOB - wobble. 524 
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Table 3. Correlation between IVOS Hamilton-Thorne CASA parameters and percentage 526 

of cells with intact acrosome and percentage of viable sperm with active mitochondria. 527 

*P<0.05. 528 

 529 

  % Sperm with an intact acrosome 
% SYBR-14+/PI-/JC-

1+ -sperm 

TM 0.13 0.26 

PM -0.07 0.33 

VCL -0.04 -0.07 

VAP -0.10 -0.13 

VSL -0.25 -0.04 

LIN -0.16 0.02 

STR -0.22 0.17 

WOB -0.14 -0.19 

BCF 0.32 -0.23 

ALH -0.36* 0.20 

 530 

Abbreviations:  TM – total sperm motility; PM – Progressive sperm motility; VAP – average 531 

path velocity; VSL– straight line velocity; VCL – curvilinear velocity; ALH – amplitude of 532 

lateral head displacement; BCF – beat cross frequency; STR – straightness of track; LIN – 533 

linearity of track; WOB - wobble. 534 

  535 

https://cris.unibo.it/


23 

This item was downloaded from IRIS Università di Bologna (https://cris.unibo.it/) 

When citing, please refer to the published version. 

 

Figure 1. 536 

 537 

a b 538 

Figure 1. CASA_bgm (a) and CASA_ (b) sperm tracker input dialog box. Some fields from 539 

the original input dialog box have been removed as not necessary for mammalian sperm 540 

analysis. 541 

 542 
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Figure 2 544 
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.  545 

VCL VAP VSL LIN STR WOB BeatCross ALH

208.4422 117.5997 92.12508 0.441969 0.783379 0.564184 22.69231 6.781614

57.10527 33.98052 33.06013 0.578933 0.972914 0.595051 33.12281 2.076376

129.6436 50.9638 40.01078 0.308621 0.785082 0.393107 31.05263 5.116851

144.441 70.79696 41.66586 0.288463 0.588526 0.490145 32.18182 5.977822

244.0964 100.948 21.53316 0.088216 0.213309 0.413558 31.05263 9.370712

180.4653 73.34014 68.32744 0.378618 0.931651 0.406395 30.51724 5.03472

204.4206 92.29341 71.11768 0.347899 0.770561 0.451488 31.95833 8.313763

187.8413 92.70441 72.69722 0.387014 0.784183 0.493525 21.73684 6.442191

102.7384 68.11353 59.32798 0.577467 0.871016 0.662981 33.39623 3.969582

199.5729 90.0397 33.60023 0.168361 0.373171 0.451162 36.22807 7.658349

241.8574 106.7313 41.69513 0.172396 0.390655 0.441299 33.71429 9.16523

208.7 86.18127 49.3397 0.236414 0.572511 0.412943 37.84906 7.227401

76.0532 19.15179 15.73174 0.206852 0.821424 0.251821 25.87719 1.602928

140.6687 66.61184 61.41458 0.43659 0.921977 0.473537 33.1875 4.324525

121.0462 65.35769 62.766 0.518529 0.960346 0.53994 28.9434 4.557494

54.04993 18.49949 17.39703 0.32187 0.940406 0.342267 35.19298 2.233654

115.7715 46.49909 40.86501 0.35298 0.878835 0.401645 26.71698 3.260101

108.198 43.05379 33.07 0.305644 0.768109 0.397917 31.60714 4.58126

180.2396 77.94228 72.54892 0.402514 0.930803 0.432437 28.48276 6.111791

100.9077 29.959 24.90571 0.246817 0.831327 0.296895 28.98246 2.371706

132.0983 73.93782 68.84734 0.521182 0.931152 0.559718 26.22222 4.748324

203.0996 90.36935 37.69428 0.185595 0.417113 0.444951 32.08772 6.62122

91.42439 66.02258 60.7103 0.664049 0.919538 0.722155 30.01754 4.684298

81.10976 30.64762 23.28496 0.28708 0.759764 0.377854 30.55357 3.196392

171.3814 67.98292 20.4941 0.119582 0.30146 0.396676 23.17857 5.500337

194.5852 89.10887 80.53256 0.413868 0.903755 0.457943 28.60606 7.859629

92.89756 63.31046 58.71605 0.632052 0.92743 0.681508 28.98246 3.358674

79.45986 32.02757 29.26935 0.368354 0.91388 0.403066 34.15789 3.14254

98.73236 64.23033 36.09186 0.365553 0.561913 0.65055 23.80702 4.135894

192.1678 104.9203 74.44733 0.387408 0.709561 0.545983 25.87719 7.032392

109.3685 52.77604 39.45234 0.360729 0.747543 0.482552 32.08772 4.843184

72.93187 35.76814 33.78304 0.463214 0.944501 0.490432 28.98246 3.288517

88.70194 42.0184 18.73911 0.211259 0.445974 0.473703 30.01754 3.674224

71.0462 35.08382 29.83453 0.419931 0.850379 0.493817 38.29824 2.85478

190.4572 96.78941 85.78745 0.450429 0.886331 0.508195 31.23529 7.854505

195.9439 109.1582 96.40215 0.491988 0.883142 0.557089 31.46667 9.582038

200.0686 100.7108 54.26265 0.27122 0.538797 0.503381 34.22 7.64082

223.7871 82.24772 23.39241 0.10453 0.284414 0.367527 22.87755 8.010928

140.1676 84.55843 78.46845 0.559819 0.927979 0.603267 30.15556 5.648967

174.6872 68.16888 56.45772 0.323193 0.828204 0.390234 27.53333 5.39762

151.3767 39.70294 29.18845 0.19282 0.735171 0.262279 28.48276 2.023471

78.01864 61.79254 58.24905 0.746604 0.942655 0.792023 29.5 2.284161

55.20258 22.50139 20.29848 0.367709 0.902099 0.407615 17.7 1.631619

120.6371 60.33001 56.47726 0.468158 0.936139 0.500095 22.37931 5.266281

145.6646 97.53716 88.55895 0.607965 0.907951 0.669601 21.07143 6.907838

128.6104 49.32986 40.31792 0.313489 0.817313 0.38356 26.22222 4.369081

TotalSperm: 68

TM PM AvgVCL AvgVAP AvgVSL AvgLIN AvgSTR AvgWOB AvgBeats AvgALH

46 32 141.0845 66.77824 48.97734 0.370955 0.761181 0.473321 29.35246 5.16817

SLOW MEDIUM RAPID

4 26 16

MedianVCL MedianVAPMedianVSL MedianLIN MedianSTR MedianWOBMedianBeatsMedianALH

136.133 67.29738 41.6805 0.366631 0.829765 0.46574 30.01754 4.938952

SigmaVCL SigmaVAP SigmaVSL SigmaLIN SigmaSTR SigmaWOB SigmaBeats SigmaALH

54.43197 26.79796 22.59057 0.153401 0.209589 0.116159 4.522693 2.198211

#############--- Color LEGEND --- #############

RED: RAPID

ORANGE: MEDIUM

GREEN: SLOW

BLACK: NOT CLASSIFIED

Parameters for motile sperm
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 546 

Figure 2. Output window produced by the plugin when the choice “1” is set at “o” and ”p” 547 

fields. In case “o” field is set to “0”, motility characteristics from single cells are not 548 

displayed; when “p” field is set to “0”, median, mean values and standard deviations of the 549 

analyzed video are not displayed. 550 

 551 
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 553 

Figure 3. 554 

 555 

 556 

Figure 3. “Paths” window. Each spermatozoon analyzed by the plugin is assigned a 557 

number, following the order of the “results” window and a color, depending on the VAP. 558 

Red, rapid cells with VAP higher than the value inserted in the input field “i”; yellow, 559 

medium cells with VAP between the value in the input field “i” and “h”; green, slow cells, 560 

with VAP lower that the value inserted in the input field “h”. Black tracks are those of non 561 

motile cells (velocities beneath).  562 

 563 
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Supplementary file 1. 565 

Bland Altman plots representing agreement between parameters measured by IVOS Hamilton-566 

Thorne CASA and CASA_bgm plugin. Each point represent a sample, measured with both 567 

instruments. Y axis expresses difference in means, while X axis expresses the average between the 568 

two measurements. The external lines represents ± 2 SD. 569 
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Total motility(TM) Bland Altman’s plot 571 

 572 

 573 

 574 

 575 

 576 

Progressive motility(PM) Bland Altman’s plot 577 

 578 

https://cris.unibo.it/


30 

This item was downloaded from IRIS Università di Bologna (https://cris.unibo.it/) 

When citing, please refer to the published version. 

 

 579 

 580 

Linear velocity (VCL) Bland Altman’s plot 581 
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 583 

 584 

 585 

 586 

Mean velocity (VAP) Bland Altman’s plot 587 
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 589 

 590 

Linear velocity (VSL) Bland Altman’s plot 591 
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Linearity (LIN) Bland Altman’s plot 597 
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Straightness (STR) Bland Altman’s plot 600 
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Beat Cross Frequency (BCF) Bland Altman’s plot 606 

 607 

 608 

Amplitude of lateral head displacement (ALH) Bland Altman’s plot 609 
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Declaration of intent. 615 

 616 

The CASA_BGM plugin was obtained by modifying and renewing the “casa” plugin Computer Assisted 617 

Sperm Analyzer designed by JG Wilson-Leedy JG and RL Ingermann and owned by the Regents of the 618 

University of California and the Howard Hughes Medical Institute. 619 

 620 

The plugin is subjected to the following conditions and terms of use: 621 

 622 

Wilson-Leedy JG, Ingermann RL, Development of a novel CASA system based on open source software for 623 

characterization of zebrafish sperm motility parameters, Theriogenology (2006), 624 

doi:10.1016/j.theriogenology.2006.10.003.  625 

Copyright © 2003 The Regents of the University of California and the Howard Hughes Medical Institute. 626 

All Rights Reserved. 627 

Permission to use, copy, modify, and distribute this software and its documentation for educational, research 628 

and non-profit purposes, without fee, and without a written agreement is hereby granted, provided that the 629 

above copyright notice, this paragraph and the following three paragraphs appear in all copies. 630 

Permission to incorporate this software into commercial products may be obtained by contacting the Office of 631 

Technology Management at the University of California San Francisco [Sunita Rajdev, Ph.D., Licensing 632 

Officer, UCSF Office of Technology Management. 185 Berry St, Suite 4603, San Francisco, CA 94107]. 633 

This software program and documentation are copyrighted by The Regents of the University of California 634 

acting on behalf of the University of California San Francisco via its Office of Technology Management and 635 

the Howard Hughes Medical Institute (collectively, the Institution).  The software program and documentation 636 

are supplied "as is", without any accompanying services from the Institution. The Institution does not warrant 637 

that the operation of the program will be uninterrupted or error-free. The end-user understands that the program 638 

was developed for research purposes and is advised not to rely exclusively on the program for any reason. 639 

IN NO EVENT SHALL THE INSTITUTION BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, 640 

SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING 641 

OUT OF THE USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF THE INSTITUTION 642 

HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. THE INSTITUTION 643 

SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE 644 

IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 645 

THE SOFTWARE PROVIDED HEREUNDER IS ON AN "AS IS" BASIS, AND THE INSTITUTION HAS 646 

NO OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR 647 

MODIFICATIONS. 648 

 649 

 650 

The purpose of our work is to implement an open source tool and share with the international reseach 651 

community our findings and, possibly, start collaborations for further implementations. We neglect and reject 652 

any commercial use of our plugin. 653 

 654 
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Brief instructions for analysis with ImageJ CASA_BGM plugin 656 

 657 

Plugin installation  658 

We report the original instruction from Wilson Leedy and Ingermann 659 

“The plugin must first be downloaded to the computer’s plugins folder and compiled 660 

(Plugins->Compile and Run, locate the file and open, see 661 

http://rsb.info.nih.gov/ij/docs/menus/plugins.html for more detailed instruction). 662 

Running the plugin will result in initiation of a dialog box where parameters for analysis 663 

may be entered (and must be entered for each analysis performed - we recommend use of 664 

a macro to input these values, macros can then be saved with particular settings for a 665 

specific species). Macros can be recorded by opening the macro recorder (Plugins->Macros-666 

>Record), and performing the analysis as normal.Clicking Create will open a new window 667 

with the text of the macro, running this macro will open the plugin, input the previously 668 

used values, and run the plugin. See 669 

http://rsb.info.nih.gov/ij/docs/menus/plugins.html#macros and 670 

http://rsb.info.nih.gov/ij/developer/macro/macros.html#recorder for more detailed 671 

instructions regarding macro recording.” 672 

 673 

Import a video in Image J and analysis 674 

 675 

After saving videos of sperm samples, these should be convertedin .avi format. 676 

To import the video into Image J after launching the software, choose File>Import>Avi…  677 

and chose the file from the correct folder. 678 

A dialog box opens and it should be indicated to import fames from 60 to 120 and to 679 

convert the image to greyscale. 680 

The video opens and the threshold should then be adjusted. Use Image->Adjust-681 

>Threshold file menu. Adjust the sliders to select spermatozoa 8red) and avoid selecting 682 

any background image (the background should be white). By clicking “Apply” the image is 683 

converted into black and white (black spermatozoa and white background). 684 

Launch the plugin and fill each field with the appropriate values (see the main article for 685 

stallion) or alternatively create and run a specific Macro. 686 

 687 

 688 
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